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A Walk Down Memory Lane: STC International Seeks Your
Memories
By the STC 50th Anniversary Committee

When STC members from across the world
gather, a favorite activity is sharing stories
about the memorable times we’ve had —
the great session at the Annual Conference
that changed our lives, perhaps a mentor in
the Society who helped with our careers, or
the technical communication “firsts” and
transitions we shared.

During such a story fest, we also laugh
about the fun times and the difficult times
that turned out to be fun — the Publica-
tions Competition conducted during a hur-
ricane in Tampa, for example.

In preparation for our May 2003 celebra-
tion of STC’s 50th Anniversary, the 50th
Anniversary Committee wants such stories

from you. We need humorous and inspira-
tional anecdotes that we can collect in an
STC archive, and we want to publish some
of your most sparkling or inspirational sto-
ries in a brochure to be distributed to all
members.

Whether you’re a Society leader or a chap-
ter member, a member of many years’ dura-
tion or one who recently joined, a technical
communication specialist or a novice, a U.S.
member or one located in another country,
we hope you will participate.

Your involvement is easy. Whenever you
think of a story you’d like to include, send
an e-mail or snail mail to Liz Babcock
(lizbab@iwvisp.com or 401 N. Warner,
Ridgecrest, CA 93555). Liz is the committee
member who has volunteered to serve as
the initial collection point for your stories.

Those stories will be most useful to us if
they are succinct (250 words or less on any
given topic) and entertaining. We would
love to receive several stories from you,
with each story to the point and on a single
topic.

Here are some questions we hope will in-
spire you:

· What amusing or inspirational story
can you tell us about how you joined
the profession? How did you over-
come obstacles that our members will
find educational or amusing?

· What career and/or Society highlight
can you share with us? (We will con-
struct a technical communication

Communicating Clarity: Make Your
Technical Marketing Matter
STC TELEPHONE SEMINAR

with Pamela Selker Rak

Where: Your office

When: March 6, 2002, 1-2:30 P.M. EST

For technology-driven companies, strate-
gic marketing has several key elements. It
must be grounded in an understanding of
customers’ unique needs. It must simplify
technically complex innovations while crys-
tallizing the benefits of these innovations.
And finally, it must create a clear, cohesive

image of the organization’s products and
services. Every communication that a com-
pany produces reflects the entire corpora-
tion.  This seminar taught participants how
to establish and maintain effective techni-
cal marketing tactics, including a distinc-
tive corporate “voice.”

For more information about the telephone
seminars and to register online, visit the
STC website at www.stc.org/seminars.html.
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January Meeting Minutes
By Elizabeth Barrow

Steve Bland and Tracy Royston spoke on
January 16, 2002, at the Pittsburgh Tech-
nology Center about the current state of
the high tech industry in the Pittsburgh
area. Tracy works for the Mayor’s Office of
Economic Development, which coordinates
resources for businesses starting in or re-
locating to Pittsburgh.  Steve (who previ-
ously worked in the same office with Tracy)
is President and CEO of Mango Start,
which helps faith-based and small busi-
nesses operate.  Here is a summary of the
meeting:

PITTSBURGH MAYOR’S OFFICE OF ECONOMIC

DEVELOPMENT

Steve Bland opened with the statement that
$1 million and 1,000 people are currently
employed in the high tech industries in
Pittsburgh. Mayor Tom Murphy started the
Office of Economic Development (OED—
and not the dictionary!) to make sure he
knew what was going on in the business
community, and to make sure Pittsburgh
would be attractive to the businesses. This
not only means such things as tax incen-
tives, but also those things that attract good
employees. The trails, riverfront develop-
ments, and downtown projects such as our
new skating rink were mentioned as ex-
amples.

Tracy Royston continued by discussing
some projects she had found particularly
interesting. These included working to at-
tract Siemens Westinghouse to the area,
and the development of Herr’s Island
(Washington’s Landing), which was cited
by Prince Charles as an excellent example
of brownfield reclamation. She added that
not only are high tech companies looking
for an available and affordable workforce,
they are looking for a very particular kind
of employee. The universities in Pittsburgh
provide the educated young people who
are needed; what Pittsburgh is trying to do
is to keep them in the area.

The OED calls local businesses, asking
what their needs are; it helps them find fi-
nancing and the employees they need. Be-
cause of that, both Steve and Tracy believe
that Pittsburgh will be in a good position to
recover from the current economic slow-
down than many other cities.

WHAT DOES THIS MEAN FOR TECHNICAL

WRITERS?

Mary Ecsedy mentioned that the reason she
had called the OED in the first place was
because the STC had such a hard time find-
ing a good place to meet. Tracy and Steve
both could think of places that might be
available, so we’ll see what happens in the
coming year. They suggested keeping up
with the Pittsburgh Technology Council
calendar to know what the “hottest” pro-
fessions were, which Steve thought were
in the biomedical field.

The PA CareerLink is the government
source for jobs. Contact them at:

www.careerlink.state.pa.us
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(Continued from page 1)

A Walk Down Memory Lane
STC International Seeks Your Memories

timeline, so your stories in this area
could be especially helpful.)

· What’s your favorite STC memory?

· What mentor or role model inspired you
in your career or in the Society? What
makes that person memorable? What
did he/she do to help you?

· What experiences, humorous or inspir-
ing, have you had with our changing
technology — typewriters to comput-
ers, red pencils to redlining?

· What can you tell us about a chapter
or regional event or accomplishment
that changed you, your chapter, or the
Society?

Help Wanted

Portfolios: Better
than Ever
MINUTES OF FEBRUARY 21 MEETING

By Nancy Carpenter

Your portfolio can be better than ever, and
Marlene Miller and Nancy Ott can tell you
how.  They have faced a lot of the issues
that any writer could face, have researched
the latest resolutions, and have incorpo-
rated their own advice into their portfolios.
They shared the results at the February
chapter meeting.

WHY DO A PORTFOLIO?
Sometimes, a portfolio (a.k.a, writing
samples) is requested. Even when not re-
quested, it is recommended for many good
reasons.  Creating a portfolio helps you to
prepare for job interviews.  It gives you room
for details that do not fit on your resume. It
can maximize your assets, proving that you
can do the job well.  It gives the interviewer
a tangible illustration of your skills, accom-
plishments, and personality.   It gives you a
competitive edge and distinguishes you
from other candidates.

GET STARTED

Don’t wait until you have an interview lined
up.  As you complete a project, get permis-
sion to put it in your portfolio.  If your em-
ployer asks whether you are seeking work,
remind him that you showed a portfolio to
him, and you make a policy of keeping it up
to date.

CONTENT

Always put your resume first.  Include a
business card.  Do not include large docu-
ments; rather use excerpts. Possible items
include chapters, online help files, web
pages or screen captures of web pages, pdfs
of online documents, reports, brochures,
newsletters, article from Blue Pencil, in-
dexes, before and after sets of chapters or
tables of contents, graphic designs, photo-
graphs of large document sets, a page show-
ing your editing markup, a PowerPoint pre-
sentation, or a movie of a set of documents.
(Lotus Smart Suite’s Screencam, and

(Continued on page 5)

This list of questions is intended to rekindle
your memories, not to restrict your flow of
ideas.

Please communicate with one of the follow-
ing people:

Liz Babcock, 401 N. Warner, Ridgecrest, CA
93555 or lizbab@iwvisp.com

Georgina Cantoni, committee chair,
gcantoni@techcomm-solutions.com

Ken Cook, kenc@kencook.com

Marguerite Krupp, mkrupp@cisco.com

Bill Leavitt, skibilll@aol.com

Ernie Mazzatenta, Jande@a-o.com

Bill Stolgitis, bill@stc.org.

We look forward to your messages!

The Pittsburgh Chapter needs volunteers
in three categories.  Job descriptions are
given below.  To apply for any of these re-
warding, interesting, and positions, please
contact one of the following chapter offic-
ers.  Application deadline is noted in the
job description.

· Pittsburgh Chapter President Mary
Ecsedy,

mary.ecsedy@verizon.net

or call at 412-422-0213

· Vice President Alan Houser,

arh@groupwellesley.com

or call at 412-363-3481

Blue Pencil Staff
Volunteers are needed to work on the
Chapter’s newsletter, either as Managing
Editor or in assistant roles.  Managing Edi-
tor is needed by May 31.  Other assistance
is welcome at any time.

Nancy Carpenter will continue as Produc-
tion Editor, assisting with all phases of pub-
lication.   She is, of course, happy to share

that with anyone for whom newsletter pro-
duction seems like good clean fun.

Treasurer Needed
The Pittsburgh Chapter of the Society for
Technical Communication is seeking a
member to fill the post of treasurer. The
treasurer’s term of office will begin April 1,
2002 and will continue through May 31,
2003.

Duties of the treasurer include bookkeep-
ing, banking, and check signing, as well as
developing chapter fund-raising activities
and serving on the chapter board. Inter-
ested members may schedule a candidate
interview by contacting one Mary or Alan
by March 22

Vice President Needed
Nominations are being taken for the office
of Vice President.  This is a two-year term
of office.  The first year is spent as Vice
President, with responsibilities for arrang-
ing the meetings for the year.  Remember
that Darlene Mullenix will assist with ar-
ranging meeting sites and taking reserva-
tions.  The second year is spent as Presi-
dent.
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People News

Society for Technical Communication

Pittsburgh Chapter
P.O. Box 133
Pittsburgh, PA 15230
Contact: Mary Ecsedy
Phone: 412-422-0213
ecsedym@worldnet.att.net

National Office
901 North Stuart Street
Suite 904
Arlington, VA 22203-1822
Phone: 703-522-4114
Fax: 703-522-2075

FebruaryFebruaryFebruaryFebruaryFebruary

Current Chapter          223

Total STC                 25,068

New MembersNew MembersNew MembersNew MembersNew Members

 Sulbha Bahl

 Randy K. Bobbert

 Ann M. Bombergen

 Tracey A. Depellegriin
Connelly

 David W. Dietz III

 Roberta A. Ryan

TechComm
Technical Writing

Experienced Technical Writer
Experienced Researcher

• Research Proposals

• Grant Proposals

• Contract Proposals

• Research Reports

• Articles

• Monographs

• Training Materials

Telephone: 412-343-2508

Telefax: 412-531-4796

blieberman2@compuserve.com

Memberandums
Congratulations, Senior Members!
The following members have reached se-
nior member status:

· Noelle C. Conover

· James Hager

· William J. O’Donnell

· Nancy Pearson

· Denise L. Wittkofski
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Employment Issues: Negotiating your Salary in a
Weakened Economy
By Pam Schmidbauer

Associate Area Manager - Aquent

Salary negotiations can be stressful at the
best of times, but in a bad economy it can
be downright frightening. There’s always
the fear that you’ll price yourself out of an
amazing new opportunity or be undercut
by the competition. The poor economy
doesn’t necessarily mean you’ll have to
settle for less when taking on a new posi-
tion.

HOLD OFF ON NEGOTIATING

Secure the job first and leave the money
discussion until the very end of the recruit-
ment process. Psychologically, once an
employer decides that you are the right can-
didate for the job, they will be willing to
offer more to bring you on board.

BE UNIQUE

Searching for a job is all about marketing a
unique product - in this case, that unique
product is you. Emphasize your unique com-
bination of skills and experience you bring
to a prospective employer. No matter how
the economy is, once the employer has de-

termined that you are the candidate they
want, then it becomes a matter of figuring
out how they can make it work for all par-
ties involved.

THINK OF THEIR BOTTOM LINE

Focus on two things when interviewing in
a poor economy - generating additional rev-
enue and cost cutting. These are skills you
want to emphasize in a weak economy be-
cause those are things that are important to
the employer. When the economy is weak,
managers are under pressure to generate a
strong bottom line. Demonstrating how you
can enhance the company’s profits by re-
ducing operating costs or improving sales
will increase your value to that company.

DO YOUR RESEARCH

You can prepare by understanding the cur-
rent employment market. Do research
through current salary surveys and your
network to find out what the real going rate
for your skills is and adjust your expecta-
tions. You must also research your prospec-
tive employer. Being aware of what is going
on within the company shows that you are
interested in working there. Before negoti-

ating your salary, keep three things in mind:
know the possible or likely perks in your
field, know the salary ranges of people in
your position, and know how your back-
ground stacks up against other candidates.

Focus on the value of the total package
and not just the total of your regular pay-
check. Perhaps this company offers career
growth. If there is a development opportu-
nity, it may be an acceptable trade-off.

Pam Schmidbauer is Associate Area Man-
ager at Aquent and can be reached at
pams@aquent.com or 412-322-4940.
Aquent (www.aquent.com) is the world’s
largest talent agency for Web, creative and
IT professionals. In its 15-year history, the
company has made more than 200,000
matches of independent professionals with
client companies worldwide. Headquar-
tered in Boston, Aquent leverages both the
Internet and its global network of offices
to provide independent professionals ac-
cess to work, professional training and the
same insurance, retirement, and cash-flow
management benefits enjoyed by tradi-
tional W-2 workers.

Macromedia’s Flash can be used to create
the movie.)  Often it is helpful, and enlight-
ening, to include annotations that explain
your role in the project, problems, solutions,
and why this is a good sample of your work.

STYLES

There are several style choices: comprehen-
sive or targeted, hard copy or online, carry
along or leave behind, binder or briefcase.
The choices you make depend on the type
of work for which you are applying, your
knowledge of what impresses the inter-
viewer, and your own comfort and skill.

Portfolios: Better than Ever
MINUTES OF FEBRUARY 21 MEETING

(Continued from page 3)
Here are some considerations to keep in
mind:

· Comprehensive portfolios contain a
representative sampling of your work
and show the breadth of your experi-
ence.  They describe you completely,
but can be too large, so trim the size of
the items.  Replace old items with newer
ones that are comparable.

· Targeted portfolios focus on a particu-
lar subject or application, most often,
the job for which you are applying.
They show the depth of your experi-
ence in that area.  They keep you from
overwhelming the interviewer with un-

necessary information, although you
might consider taking the rest of your
samples in a separate binder because
you might find that something will in-
terest the interviewer and sway him in
your direction.

· Hard copy is appropriate in many cases.

· Online is particularly appropriate if the
job requires online work.  You can be
comprehensive and targeted with this
medium.

· Whether you leave samples depends
on whether they are proprietary and
on whether you are comfortable hav-

(Continued on page 9)
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(Continued on page 7)

Tools and Tips: Word 2002 – First Look
 By Robert P. Mohr

I’ve been using Word 2002 (aka XP) for a
couple of months now and have found it to
be a big improvement over previous ver-
sions.  The interface is basically the same;
the real difference lies in several new fea-
tures: task panes, smart tags, a drawing can-
vas, and the HTML filter.

TASK PANES

A task pane is an additional bit of screen
area that sits off to the right of the docu-
ment you’re working on. For example, here’s
the Styles and Formatting task pane:

FIGURE 1: STYLES AND FORMATTING TASK

PANE

There are eight different task panes:

· New Document – this pane displays a
list of previously opened files, lets you
create a new blank document, or offers
a gateway to your templates folders.
In fact, clicking File > New, as you
would to select a template, now dis-
plays the New Document task pane.
The difference is more options are dis-
played.

· Clipboard – this pane shows you the
contents resulting from multiple cop-
ies to the Clipboard. Each time you do
a paste operation, a clipboard icon ap-
pears offering several paste options.

Graphics referenced in the Clipboard
task pane are shown as thumbnails;
text selections are referenced with their
first dozen words or so. Pressing Ctrl+C
twice is a hot-key sequence that pops
up the Clipboard task pane if it’s not
already open.

FIGURE 2: CLIPBOARD TASK PANE

· Search – this pane acts much the same
way the Windows Find works. You can
search for text within specified file types
and locations.

· Insert Clip Art – this pane has a built-
in search feature that lets you search
based on text, clip art collections, and
media file types. It’s also a gateway to
the Clip Art Organizer and Microsoft’s
online Clip Art Gallery.

· Styles and Formatting – this pane is
much like the old Format > Style op-
tion in that it lets you modify and cre-
ate styles. However, as you can see in
Figure 1, all of the styles used in the
current document are shown in a
scrollable list for easy reference and
access. You can highlight text in your
document and select a style from the
task pane to apply it. It works very
much like FrameMaker’s paragraph
catalog.

· Reveal Formatting – this pane contains
a feature that former WordPerfect us-
ers have longed for in Word. Using the
Reveal Formatting task pane, you can
see exactly which attributes have been
applied to the text in question. 

Figure 3 shows an example of this task pane.

FIGURE 3: REVEAL FORMATTING TASK PANE

The content of the Reveal Formatting task
pane updates dynamically as you move from
text to text in your document.

· Mail Merge – this pane really fronts as
a six-step merge wizard. The wizard
prompts you for information regarding
the primary (merge to) document and
the data source (merge from) docu-
ment. The data source can also be a
table from an Access database—and
you can select specific data from the
table as well.  The mail merge toolbar
provides much the same functionality
as the task pane.

· Translate – this pane seems to offer
language translation services.  You can
translate selected words from the cur-
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(Continued from page 6)

Tools and Tips: Word 2002 – First Look

rent document, or the entire document,
select the target language, and let Word
do the translation. The use of this task
pane requires the installation of the lan-
guage translation modules (which I
didn’t install). 

SMART TAGS

Smart tags are used in conjunction with data
of a specific type that Word recognizes. It
is up to you to select the types of data you
want Word to recognize.

FIGURE 4: SMART TAG SETUP

As you can see in Figure 4, Word can rec-
ognize a person’s name. When it does, it
underlines the name with a dotted line and
displays an icon that you can click on to
drop-down several options. For example, if
I clicked on the name “Bill Smith” and
clicked on the smart tag icon, I would see
the options.shown in Figure 5.

FIGURE 5: SMART TAG OPTIONS

 As with the other new features in Word,
the smart tags are designed to help you
work more efficiently.

NEW DRAWING FEATURES

In the past, Word enabled you to make draw-
ings in your documents; however, they were
difficult to control and once made, resizing
them was even more difficult.  Word’s new
drawing canvas has made drawing creation
much easier and far more flexible than be-
fore.  The drawing canvas has its own set
of attributes, just like the other drawing
objects have: text wrapping, borders, col-
ors, positioning, etc., along with one other
key attribute: Scale Drawing.  Before, when
you grouped several drawing objects and
resized them, the objects shrunk, but their
text remained the original size. This required
the time-consuming task of reducing the
font sizes to match the objects. The Scale
Drawing feature changes all of that. Now
you can drag a corner of the drawing can-
vas and everything in it—including the
text—resizes proportionately.

A new addition to the standard drawing
tool set is an organization chart and dia-
gram maker. Five types of diagrams are avail-
able: cycle, radial, pyramid, Venn, and tar-
get.

And, finally, a set of nine connector types
has been added to the AutoShapes library.
These make it easy to draw connecting lines
and arrows between the other AutoShapes
and objects.

CLEANER HTML
Word 2002 has a built-in HTML filter de-
signed to create “clean” HTML files. This
is in addition to its normal Web page out-
put, which does create a seemingly exces-
sive amount of tags so as to accommodate
“round-tripping” from DOC to Web, and
back to DOC again.

Creating a clean HTML file is nearly the
same as creating a Web page:

- On the File menu, click Save As.

- In the Save as Type box, click Web

Page, Filtered.

- Click Save.

ODDS AND ENDS

Booklet printing used to be a real pain in
other versions of Word. Now it’s a piece of
cake. All you need do is select the Book
fold option in the Pages section of the Page
Setup dialog box. Word handles the rest.
To print the booklet, use your printer’s du-
plex capability, or use the manual/duplex
printing option found in Word’s Print dia-
log box. In effect, you print all of the odd
pages in one pass, then replace the sheets
in the printer, answer a prompt, and print
the other half. I tested the manual method
on a sample booklet, and it worked great.

The same flexibility in customizing the
toolbars and menus still exists in Word 2002,
though a few of the steps to do so are
slightly different.  Any custom toolbars and
menus you use now should be acceptable
in the eyes of Word 2002.  Mine were. The
first thing I did after installing the new Word
was to delete its Normal.dot file and replace
it with my old Normal.dot file from Word
2000. Word 2002 accepted it without
question. All of my macros, toolbar icons,
and menu options remained exactly the
same.

All in all, I’m pleased with Word’s new look
and new feature set. Give it a try.   I’m sure
you’ll like it too.

Bob Mohr is a senior member of STC and a
technical writer at BillingZone, LLC.   He
can be reached through email at
bob.mohr@billingzone.com.

Salary Survey
The latest salary survey was published in
the September/October issue of Intercom.
You can find all the surveys from 1997 to
2001 at the following link:

http://www.stc.org/salary.html
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(Continued from page 8)

Portfolios: Better than Ever
MINUTES OF FEBRUARY 21 MEETING

ing people read your work without be-
ing there to explain things.

· Office supply stores have many inex-
pensive and professional looking
cases, some with numerous pockets
and with pull-out handles.  The brief-
case or binder should look professional
and not fall apart if dropped.  A table
of contents and tabs will look impres-
sive and help you navigate.  Sheet pro-
tectors will keep the samples clean and
neat.  Magazine holders are available
to hold an entire issue.  Envelops are
available for CD-ROMs. The CDs
should have labels and be in jewel
cases, even if they are in a binder en-
velop.  Be sure to put your name and
contact information on the label.  Be
sure to virus scan it!  Put an autorun
program on it to avoid clumsy startup,
but inform the interviewer first that you
have done this, in case he has any op-
erating system problems with it.
Websites should be easy to read and
logically organized.  Avoid busy back-
grounds.  Check all links!

THINK AHEAD

If you are taking a CD or plan to show a
website, ask the interviewer what facilities
are available — a computer, in case you do
not have a laptop; power, in case your
laptop battery does not last long enough;
large projection equipment, in case there
will be more than one or two people in the
room.

PERMISSION

You must get permission to use work you
were employed to do.  If confidentiality is a
problem, ask whether you can extract a por-
tion or make some changes that will make
the piece acceptable to use.  Negotiate to
see whether  you can present the item, but
not leave any samples.  Create a mock
sample that is similar to the one you wanted
to use, but uses no proprietary data, but be
sure to inform the interviewer that you have

done this, since you did not have permis-
sion to show the real information.

BUT I HAVE NO SAMPLES

Yes, you do.  You can create them in many
ways.  Volunteer to create a website, news-
letter, brochure, or user’s guide for your
church, hobby, STC, a freeware software
developer, or an open source application
developer.  Use school papers and reports,
and describe what they show about your
skills.

PRESENTATION TECHNIQUES

Practice so that you can navigate easily
through the portfolio.  Anticipate questions
and interruptions, and practice responses.
Annotate items to help you remember what
you wanted to say.

If no portfolio was requested, offer it, but
do not force it on someone.  Present with
confidence.  Maintain control of the port-
folio—do not hand it over to the interviewer.

AND FINALLY

Keep this article in a folder with your re-
sume.  The advice is timeless.

Board Meeting,
March 6
Your officers held a board meeting on March
6, 2002. The items discussed included the
following:

····· Treasurer and Vice President.  These
positions must be filled by the end of
this season.

····· Meeting Notices.  Processes were put
in place for getting the meeting notices
disseminated by the end of the first
week of the month.

····· Your Contact Information.   A link will
be placed on the web site to allow mem-
bers to update their personal contact
information.

····· April and May Meetings.  The last few
meetings of this season will have
speakers.  A summer fun gathering still
is in discussion.

····· Next Season’s Meetings.  Half the meet-
ings for the 2002-03 season are planned
and confirmed.

····· Email.  The chapter listserv contains
only about half our members.  Its in-
stantaneous communication needs to
be extended to the entire membership.

····· Chapter Work.   Volunteers are greatly
needed in all areas of chapter work.

····· Competition.  No competition awards
were given this Spring because too few
candidates were received.

····· Writers Available/Needed.  Employ-
ment in Pittsburgh is on the rise!  Keep
posting your notices with Noelle
Conover, our employment coordinator.

····· Fund raising.  We will need to raise
funds for the chapter soon.  Ideas are
being solicited.

The board wants to remain responsive to
the needs of the members.  If you have an
item that you want the board to consider,
please notify Mary C. Ecsedy at:

<mary.ecsedy@verizon.net>
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P.O. Box 133
Pittsburgh, PA 15230

MARCH, 2002

ONLINE HELP AUTHORING TOOLS BY COMPONENTONE

WHEN : Tuesday, March 19, 2002
5:30 - 6:30 (dinner and network
ing)

6:30 - 7:30 (presentation)

WHERE : Jameson’s Restaurant,
45 Bates Street in Oakland (just
off the Bates Street exit of the
Parkway East).

COST: $12 for STC members

        $13 for non-members

        $5 for students and unemployed

RSVP: Please reply by 3 pm on
Monday, March 18, to Darlene
Mullenix, Meeting Coordinator,
by calling her at (412) 288-8676
or by emailing her at
dmullenix@federatedinv.com.

Monthly Chapter
Meeting
TOPIC:
Online Help Authoring Tools by
ComponentOne

A TRIVIA QUESTION:
One of the two largest vendors of authoring
tools for Windows online help is based in:

A. Boston

B. San Francisco

C. Pittsburgh

If you guessed (C), you are correct!
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